Networking Basics
Assigning a Static IP Address
in Windows XP/2000

B Click on Internet Protocol
(TCPIIP)

B Click Properties

® Input your IP address and
subnet mask. (The IP
Addresses on your network
must be within the same
range. For example, if one
computer has an IP Address
of 192.168.0.2, the other
computers should have IP
Addresses that are
sequential, like 192.168.0.3
and 192.168.0.4. The subnet
mask must be the same for
all the computers on the
network.)

B Input your DNS server
addresses. (Note: If you
are entering a DNS
server, you must enter the
IP Address of the Default
Gateway.)

The DNS server information will be supplied

by your ISP (Internet Service Provider.)

B Click OK

-L liocal Area Connection 7 Properties

PIX)

General | Advanced

Connect using:

B3 D-Link DWL-AB50

This connection uzes the following items:

El, Clignt for Microzoft Metworks

Il .@ File and Printer Sharing for Microzoft Networks
=) 305 Packet Scheduler
Intemet Pratacal [TCPAR) '

D' escription

Tranzmizzion Contral Protocaol/|ntermet Pratocol. The default
wide area network, protocol that provides communication
aciogs diverse inkerconnected networks.

[ Show icon in notification area when connected

Ok ] I Cancel

RIX]

Internet Protocol (TCP/IP) Properties
General

You can get [P settings assigned automatically if your network, supports
this capability. Otherwize, you need to ask your netwaork, administrator for
the appropriate [P settings.

() Obtain an IF address automatically

‘G) Uze the following IP address '
|P address: [192 . 188. 0 . 2 |
Subnet mask: 255 . 255 . 565, 0

Default gateway:

(@ Usg the following DNS server addresses.)

Preterred DNS server

Alernate DMS server

Ce )
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Networking Basics
Assigning a Static IP Address with Macintosh OSX

1) =
) -F X NN
B Go to the Apple Menu and se- m m e me s e
lect System Preferences S P i
N R
| i ey
Click on Network o @ Q i
‘88 Netwark [=]
B Select Built-in Ethernetinthe '« = & @ O
Show pull-down menu _
Location:  Automatic ?‘
Show: | Bulh-in Ethernet i
m SelectManually inthe Con- - G
figure pull-down menu T i
Using BootP

e Servers iOpdomal
1P Address
(Provided by DHCP Server)
Subnet Mask: 255.255.255.0
Router: 192.188.0.1 Search Domains Dpeionall
DHCP Client 1D
(Dpcionaly

Lnample: agale.com. earthlinknet
Ethernet Address.

(@) Click the lock to prevent further changes.

‘88 Nerwark =

« HA@ 3@

Show All  Duplays Sound Network Startup Disk

Location:  Automatic -=-1

B Inputthe Static IP Address, UL —

the Subnet Mask and the o L o
Router IP Address in the ap- Costguon: [Ty G

propriate fields ) Pemnfmetomone

1P Address. 16216802

Subnet Mask:  255.255.255.0
. Search Domains iDpeional)

Eouter

Lxample: agple.com. sarthlinknet
Ethernet Address. D0.09.93.75.de-5a

B Click Apply Now

(&) Click the lock to prevent further changes. (" Apply Now
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Networking Basics
Selecting a Dynamic IP Address with Macintosh OSX

B  Go to the Apple Menu and select

System Preferences

B Click on Network

Show pull-down menu

B Select Using DHCP in the
Configure pull-down menu

B Click Apply Now

B ThelP Address, Subnet
mask, and the Router’s IP
Address will appear in a few
seconds

Select Built-in Ethernet in the

e =
w & D ]
Persanl
- = B @ & @
[ I i
Harduars
e = @ % 4
[ . T =]
Irhereet & etz
s@ar
—— R
Stem
9 & & @ 4
c DeniTes  Mhwe  Geeh  NewmOik U
®0 Nework =
« @A O
Show AN Dwplays Scund Network  S1ariup Duk
Location: | Automatic 5
Shew:  Bulh-in Ethernat -ﬂ
——- = e —y
—— Manually s
+ Using DHCP
S CooT
1P Address
(Provided by DHCP Server)
Submet Mask. 255.255.255.0
Router 19216801 SEAER DO ifts —— opRcnih
DHCP Client 1D
iOptienal
Fram e eom, rarthliok net
Ethernet Addrec ezian o =
@ Click the lock to prevent fusther changes. Apply Now
[-):] Netwark (=]

“« = A4 3

Show Al Dhiplays Sound Network Startup Disk

Location: | Autamatic )
Shaw: | Built-in Ethernet 3]
feene | preok | AppleTalk | Proxies
Configure: | Using DHCP i)

Domain Name Servers iOgtianali
P Address: 192.168.0.160
{Pravadied by DHCF Serven)
Subnet Mask 255 255.255.0

Router: 192,168.0.1 Search Damaing (Dptianal)

DHCP Client 1D
IDprianal)

Example; agole.com, earthlinknet

Ethernet Address: 00.06.98: 79 de 52

(&) Chck the lnck to prevent further changes  Apply Now




Networking Basics
Checking the Wireless Connection by Pinging in Windows XP and

2000

m GotoStart>Run > BEE
type cmd. Awindow et e P o B
Similar to thls one [F:\Documents and Settings\lab4>ping 192.168.8.58

ll T Pinging 192.168.0.50 with 32 hytes of data:
Wi appear' ype Rewly fron 192.168.0.50: hyt

A cply £rom :
ping Fonly Fron 175.165.0.58:

XXX XXX XXX.XXX, T
where xxx is the IP SIS R LN HRL R
Address of the IP:\Documents and Settings\lah4>_
Wireless Router or
Access Point. A
good wireless
connection will show
four replies from the
Wireless Router or
Acess Point, as
shown.

Checking the Wireless Connection by Pinging in Windows Me
and 98

B Goto Start> Run
> type command.
A window similar to
this will appear.
Type ping
XXX XXX XXX. XXX
where xxx is the IP  EEST=
Address of the S
Wireless Router or
Access Point. A
good wireless
connection will
show four replies
from the wireless
router or access
point, as shown.
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Troubleshooting

This Chapter provides solutions to problems that can occur during the installation and
operation of the DI-624 Wireless Broadband Router. We cover various aspects of the
network setup, including the network adapters. Please read the following if you are having
problems.

Note: Itis recommended that you use an Ethernet connection to
configure the DI-624 Wireless Broadband Router.

1.The computer used to configure the DI-624 cannot access the
Configuration menu.

B Check that the Ethernet LED on the DI-624 is ON. If the LED is not
ON, check that the cable for the Ethernet connection is securely
inserted.

B Check that the Ethernet Adapter is working properly. Please see
item 3 (Check that the drivers for the network adapters are
installed properly) in this Troubleshooting section to check that

the drivers are loaded properly.

B Check that the IP Address is in the same range and subnet as the
DI-624. Please see Checking the IP Address in Windows XP in
the Networking Basics section of this manual.

Note: The IP Address of the DI-624 is 192.168.0.1. All the computers on the
network must have a unique IP Address in the same range, e.g., 192.168.0.x.
Any computers that have identical IP Addresses will not be visible on the
network. They must all have the same subnet mask, e.g., 255.255.255.0

B Do aPing test to make sure that the DI-624 is responding. Go to
Start>Run>Type Command>Type ping 192.168.0.1. A successful
ping will show four replies.

[~ cwoomsspmiendon  GIR
Note: If you have
changed the default IP
Address, make sure to
2, @ Tosed, ping the correct IP
o Address assigned to the
DI-624.
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Troubleshooting

2. The wireless client cannot access the Internet in the
Infrastructure mode.

Make sure the wireless client is associated and joined with the correct Access
Point. To check this connection: Right-click on the Local Area Connection icon
in the taskbar> select View Available Wireless Networks. The Connect to
Wireless Network screen will appear. Please make sure you have selected the

correct available network, as shown in the illustrations below.

Disable The followaing network[z] are available. To access a network, select
it from the list, and then click Connect.
Status

Repair Available nebworks;

1 alan ~

E dah

i nn

St

If you are having difficulty connecting to a netwark, click Advanced.

[ Connect l[ Cancel ‘

B Check that the IP Address assigned to the wireless adapter is within the
same IP Address range as the access point and gateway. (Since the
DI-624 has an IP Address of 192.168.0.1, wireless adapters must have
an IP Address in the same range, e.g., 192.168.0.x. Each device must
have a unique IP Address; no two devices may have the same IP
Address. The subnet mask must be the same for all the computers on
the network.) To check the IP Address assigned to the wireless adapter,
double-click on the Local Area Connection icon in the taskbar >
select the Support tab and the IP Address will be displayed. (Please
refer to Checking the IP Address in the Networking Basics section of
this manual.)

B Ifitis necessary to assign a Static IP Address to the wireless adapter,
please refer to the appropriate section in Networking Basics. If you are
entering a DNS Server address you must also enter the Default
Gateway Address. (Remember that if you have a DHCP-capable router,
you will not need to assign a Static IP Address. See Networking

Basics: Assigning a Static IP Address.)
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Troubleshooting

3. Check that the drivers for the network adapters are

installed properly.

You may be using different network adapters than those illustrated here, but this
procedure will remain the same, regardless of the type of network adapters you are

using.

m Goto Start> My
Computer >
Properties

m Select the
Hardware
Tab

B Click Device
Manager

i"’ Windows Media Player I
Open

Explore

G? Control P Search...

Manage
e Conneck
)

-‘é Printers ¢

Map Metwork Drive, .,
Disconnect MNetwork Drive. .

v Show on Desktop

@ Help and  Rename

'_.) Search
=7 Run...

All Programs D

m‘l Log OFF '®|Turn OFf Computer

System Properties

Remate
Advanced

| System Restore Automiatic Up

Il
Computer Mame

| General |

Add Hardware ‘Wizard
% The Add Hardware “Wizard helps you install hardware,

Add Hardware ‘Wizard

Device M anager

The Device Manager lists all the hardware devices installed
on pour computer, Use the Device Manager to change the

properties of any device.
] i Device Manager ;

b e

Hardware profiles provide a way for you to set up and store
different hardware configurations.

[ Ciriver Sianing

Hardware Profiles

[ Hardware Prafiles J

u]8 ][ Cancel ] Apply




Troubleshooting

B Double-click
on Network
Adapters

B Right-click on D-Link
AirPlus DWL-G650
Wireless Cardbus
Adapter (In this example
we use the DWL-G650;
you may be using other
network adapters, but the
procedure will remain the
same.)

B Select Properties
to check that the
drivers are in-
stalled properly

B LookunderDevice
Status to check that the
device is working

properly

B Click OK

Z¢ Device Manager

File  Action Wiew Help
e 2 =R a

] %‘ PMTEST
[+ ﬁ Eatteries

+ g Computer

+ e Disk drives

+ _g Display adapters

+i=) Flappy disk contrallers

+ g Floppy disk drives

53 [@ IDE ATASATAPT contrallers
+

g

ol

=

J Keyboards
_J Mice and other pointing devices
E’ Modems
Manitars
Metwork. adapters

£} D-Link AirPlus DWL-G650

B PCMCIA adapkers

F‘,‘ Ports (COM & LPT)

| 8 Processors

@, sound, video and game controllers

¢ System devices
Universal Serial Bus controllers

H [

D-Link AirPlus DWL-G650 Wireless Cardbus Adapter

General ._Advanc:ed Settings | Driver | Resources

F——F D-Link AirPlus DWL-G650 Wireless Cardbus Adapter

Device type: Metwork adapters
Manufacturer: D-Link
Location: PCl busz 5, device 0, function 0 |

Device status

:.This device iz working properly.

|1 you are having problems with this device, click Troubleshoat to
| start the troubleshooter.

Troubleshoot. .. |

Dewce usage:

| Use this device [enable] v|




Troubleshooting

4. What variables may cause my wireless products
to lose reception?

D-Link products let you access your network from virtually anywhere you want. However,
the positioning of the products within your environment will affect the wireless range.
Please refer to Installation Considerations in the Wireless Basics section of this manual
for further information about the most advantageous placement of your D-Link wireless
products.

5. Why does my wireless connection keep dropping?

m Antenna Orientation- Try different antenna orientations for the DI-624. Try to
keep the antenna at least 6 inches away from the wall or other objects.

W If you are using 2.4GHz cordless phones, X-10 equipment or other home secu-
rity systems, ceiling fans, and lights, your wireless connection will degrade dra-
matically or drop altogether. Try changing the Channel on your Router, Access
Point and Wireless adapter to a different Channel to avoid interference.

B Keep your product away (at least 3-6 feet) from electrical devices that generate
RF noise, like microwaves, monitors, electric motors, etc.

6. Why can’t | get a wireless connection?

If you have enabled Encryption on the DI-624, you must also enable encryption on all
wireless clients in order to establish a wireless connection.

B For 802.11g, the Encryption settings are: 64 or 128 bit. Make sure that the
encryption bit level is the same on the Router and the Wireless Client.

B Make sure that the SSID on the Router and the Wireless Client are exactly the
same. If they are not, wireless connection will not be established.

B Move the DI-624 and the wireless client into the same room and then test the
wireless connection.

B Disable all security settings. (WEP, MAC Address Control)
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Troubleshooting

6. Why can’t | get a wireless connection? (continued)

Turn off your DI-624 and the client. Turn the DI-624 back on again, and then turn
on the client.

Make sure that all devices are set to Infrastructure mode.

Check that the LED indicators are indicating normal activity. If not, check that the
AC power and Ethernet cables are firmly connected.

Check that the IP Address, subnet mask, gateway and DNS settings are cor-
rectly entered for the network.

If you are using 2.4GHz cordless phones, X-10 equipment or other home security
systems, ceiling fans, and lights, your wireless connection will degrade dramati-
cally or drop altogether. Try changing the Channel on your DI-624, and on all the
devices in your network to avoid interference.

Keep your product away (at least 3-6 feet) from electrical devices that generate
RF noise, like microwaves, monitors, electric motors, etc.

7. | forgot my encryption key.

Reset the DI-624 to its factory default settings and restore the other devices on
your network to their default settings. You may do this by pressing the Reset
button on the back of the unit. You will lose the current configuration settings.
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Troubleshooting

8. Resetting the DI-624 to Factory Default Settings

After you have tried other methods for troubleshooting your network, you may
choose to Reset the DI-624 to the factory default settings. Remember that D-
Link AirPro products network together, out of the box, at the factory default
settings.

Reset

To hard-reset the DI-624 to Factory Default Settings, please do the following:

B | ocate the Reset button on the back of the DI-624
B Use a paper clip to press the Reset button

B Hold for about 10 seconds and then release

m After the DI-624 reboots (this may take a few minutes) it
will be reset to the factory Default settings
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Technical Specifications

Standards
B |EEE 802.119g
B I|IEEE802.11b

m |EEE 802.3
m |EEE 802.3u
VPN Pass Through/ Multi-Sessions
m PPTP
B L2TP
m IPSec

Device Management

B Web-Based- Internet Explorer v6 or later; Netscape Navigator v6
or later; or other Java-enabled browsers

B DHCP Server and Client

Advanced Firewall Features

B NAT with VPN Passthrough (Network Address Translation)
MAC Filtering
IP Filtering
URL Filtering
Domain Blocking
B Scheduling
Wireless Operating Range
B Indoors — up to 328 feet (100 meters)
B Outdoors — up to 1312 feet (400 meters)
Operating Temperature
B 32°F to 131°F (0°C to 55°C)

Humidity:
B  95% maximum (non-condensing)

Safety and Emissions:
B FCC

Wireless Frequency Range:
B 24GHzto 2.462GHz
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Technical Specifications

LEDs:
Power

WAN
LAN (10/100)

WLAN (Wireless Connection)

Physical Dimensions:

B L =7.56inches (192mm)
B W =4.65 inches (118mm)
m H=1.22 inches (31mm)

Wireless Transmit Power:
[ ] 17dBM

Security:

B 802.1x

B  WPA- WiFi Protected Access
(64-,128-WEP with TKIP, MIC, IV Expansion, Shared Key
Authentication)

External Antenna Type:
B Single detachable reverse SMA

Modulation Technology:
B Orthogonal Frequency Division Multiplexing (OFDM)

Power Input:
B Ext. Power Supply DC 7.5V, 1A

Weight:

m 10.8 oz. (0.3kg)
Warranty:

B 3year
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Technical Specifications

Wireless Data Rates with Automatic Fallback:

108 Mbps
54 Mbps
48 Mbps
36 Mbps
24 Mbps
18 Mbps
12 Mbps
11 Mbps
9 Mbps
6 Mbps
5.5 Mbps
2 Mbps

1 Mbps

Receiver Sensitivity:

m 108Mbps

B 54Mbps OFDM, 10% PER, -68dBm
B 48Mbps OFDM, 10% PER, -68dBm
36Mbps OFDM, 10% PER, -75dBm
24Mbps OFDM, 10% PER, -79dBm
18Mbps OFDM, 10% PER, -82dBm
12Mbps OFDM, 10% PER, -84dBm
11Mbps CCK, 8% PER, -82dBm
9Mbps OFDM, 10% PER, -87dBm
6Mbps OFDM, 10% PER, -88dBm
5.5Mbps CCK, 8% PER, -85dBm
2Mbps QPSK, 8% PER, -86dBm
1Mbps BPSK, 8% PER, -89dBm
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Frequently Asked Questions

Why can’t | access the web based configuration?

When entering the IP Address of the DI-624 (192.168.0.1), you are not connecting to
the Internet or have to be connected to the Internet. The device has the utility built-in

to a ROM chip in the device itself. Your computer must be on the same IP subnet to

connect to the web-based utility.

To resolve difficulties accessing a web utility, please follow the steps below.

Step 1 Verify physical connectivity by checking for solid link lights on the device. If
you do not get a solid link light, try using a different cable or connect to a different
port on the device if possible. If the computer is turned off, the link light may not be
on.

What type of cable should | be using?

The following connections require a Crossover Cable:
Computer to Computer

Computer to Uplink Port

Computer to Access Point

Computer to Print Server

Computer/’XBOX/PS2 to DWL-810
Computer/XBOX/PS2 to DWL-900AP+

Uplink Port to Uplink Port (hub/switch)

Normal Port to Normal Port (hub/switch)

The following connections require a Straight-through Cable:
Computer to Residential Gateway/Router

Computer to Normal Port (hub/switch)

Access Point to Normal Port (hub/switch)

Print Server to Normal Port (hub/switch)

Uplink Port to Normal Port (hub/switch)

Rule of Thumb:
"If there is a link light, the cable is right.”
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Frequently Asked Questions (continued)

Why can’t | access the web based configuration? (continued)

What type of cable should | be using? (continued)

What's the difference between a crossover cable and a straight-through
cable?

The wiring in crossover and straight-through cables are different. The two types
of cable have different purposes for different
LAN configurations. EIA/TIA 568A/568B

. .. 1 White-Green
define the wiring standards and allow for g gﬁ..tan o
two different wiring color codes as 1 Blue o l4e
illustrated in the following diagram. g ‘(-;‘-:?;;flue
. . 7 White-Brown
*The wires with colored backgrounds may 8 Brown

have white stripes and may be denoted 5684 CABLE END
that way in diagrams found elsewhere.

1 White-Orange
How to tell straight-through cable f 3 g
ow to tell straight-through cable from 3 White-Green
. 4 Blue
acrossover cable: _ 5 Whie.Blue
The main way to tell the difference 6 Green
R 7 White-Brown
between the two cable types is to compare 8 Brown

the wiring order on the ends of the cable. If
the wiring is the same on both sides, it is
straight-through cable. If one side has opposite wiring, it is a crossover cable.

5688 CABLE END

All'you need to remember to properly configure the cables is the pinout order of
the two cable ends and the following rules:

A straight-through cable has identical ends

A crossover cable has different ends

It makes no functional difference which standard you follow for straight-through
cable ends, as long as both ends are the same. You can start a crossover cable
with either standard as long as the other end is the other standard. It makes no
functional difference which end is which. The order in which you pin the cable is
important. Using a pattern other than what is specified in the above diagram
could cause connection problems.

When to use a crossover cable and when to use a straight-through cable:
Computer to Computer — Crossover

Computer to an normal port on a Hub/Switch — Straight-through

Computer to an uplink port on a Hub/Switch - Crossover

Hub/Switch uplink port to another Hub/Switch uplink port — Crossover

Hub/Switch uplink port to another Hub/Switch normal port - Straight-through
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Frequently Asked Questions (continued)

Why can’t | access the web based configuration? (continued)

Step 2 Disable any Internet security software running on the computer. Software
firewalls like Zone Alarm, Black Ice, Sygate, Norton Personal Firewall, etc. might
block access to the configuration pages. Check the help files included with your
firewall software for more information on disabling or configuring it.

Bl Sousoty | Povany | Corserd | Cormmonons | Pragrems | ibvwand |

Step 3 Configure your Internet settings.

Go to Start>Settings>Control Panel. Double click Pyt e |

the Internet Options Icon. From the Security tab, i
click the button to restore the settings to their T e
defaults. 4
e e ot
o e
I S 1=
Gorml| Socunty | Fivacy | Cortert Corrwcionn | P | dvarced]
;1 [1 o il
Click the Connection tab and set the dial-up “r_—“““”* |
option to Never Dial a Connection. Click RN —
the LAN Settings button. %
e

r
Ll e b LA

g
G T e — —‘—J“" -
O S i~ |

bt coniga s
Rubcmas: corbcpasin may ovesde v sty [ manthe
i e, oot A

I psmancly e g

Nothing should be checked. Click OK. iy e e

P s
25w a e bon ponat LAN [ hew iwtargs vl sy 1o
T Gip Ve corrmcior

[r— == |

- |

st momatc:

r

et Fropevtes ]
G| Sncusty | Prcacy | Corterd | Convectorn | Prgmm Advares

Go to the Advanced tab and click the
button to restore these settings to their

defaults.

o
o
B

a8
=]
B
8
u}
o
=]
8
8
=]
=]
o

Click OK. Go to the desktop and close any open
windows.




Frequently Asked Questions (continued)

Why can’t | access the web based configuration? (continued)

Step 4 Check your IP Address. Your computer must have an IP Address in the
same range of the device you are attempting to configure. Most D-Link devices use
the 192.168.0.X range.

How can | find my IP Address in Windows 95, 98, or
ME?

Step 1 Click on Start, then click on Run.

Step 2 The Run Dialogue Box will appear. Type winipcfg in the window as shown
then click OK.
Run 2]

Tupe the name of & program, folder, or document, and
windows will open it for yo.

Open: |winipcfg j

ok i Cancel | Browse... I

Step 3 The IP Configuration window will appear, displaying your Ethernet
Adapter Information.

B Select your adapter from the drop down menu.

M If you do not see your adapter in the drop down menu, your adapter is
not properly installed.

IP Configuration =& K3

— Ethernet Adapter Infoimation

[PEF
Adapter Address [ |
Default Gateway
ok I EElease | EEmsw |

Feleaze Al | Renew All | Hore Info »> |

Step 4 After selecting your adapter, it will display your IP Address, subnet
mask, and default gateway.
Step 5 Click OK to close the IP Configuration window.
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Frequently Asked Questions (continued)

Why can’t | access the web based configuration? (continued)

Step 4 (continued) Check your IP Address. Your computer must have an |IP Address
in the same range of the device you are attempting to configure. Most D-Link devices
use the 192.168.0.X range.

How can | find my IP Address in Windows 2000/XP?

Step 1 Click on Start and select Run.

Step 2 Type cmd then click OK.
Run @ o

- Twpe the name of a program, folder, document, or
Internet resource, and Windows will open it Far wau.

Cper; | u—r :-v_

[ Ok J[ Cancel H Browse. .. |

Step 3 From the Command Prompt, enter ipconfig. It will return your IP
Address, subnet mask, and default gateway

S WINNT system32' CMD.EXE

Microsoft Windows 2BAA [Uersion E.ﬁ 21951
CC» Copyright 1985-28B@ Microsoft Corp.

D:~>ipconfig

Windows 2888 IP Configuration

Ethernet adapter Local Area Connection:
Connection—specific DNS Suffix

IP AQAPeSS. = . = » = » o « = « . ¢ 192.168.8.174
Subnet Mask T 255.255.255.8

Default Gateway - 192.168.8.1

Step 4 Type exit to close the command prompt.
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Frequently Asked Questions (continued)

Why can’t | access the web based configuration? (continued)

Step 4 (continued) Check your IP Address. Your computer must have an IP

Address in the same range of the device you are attempting to configure. Most D-Link
devices use the 192.168.0.X range.

Make sure you take note of your computer’s Default Gateway IP Address. The Default
Gateway is the IP Address of the D-Link router. By default, it should be 192.168.0.1.

How can | assign a Static IP Address in Windows XP?
Step 1

Click on Start > Control Panel > Network and Internet Connections >
Network connections.

Step 2 See Step 2 for Windows 2000 and continue from there.

How can | assign a Static IP Address in Windows 20007
Step 1 Right-click on My Network

B R e Fpotm Tk Adaged e

Places and select Properties. »Z:mm.l_m.“mi’fi.f:; — :m
o) g 13 = an Cd
Step 2 Right-click on the Local pemk vy S5 S

Area Connection which represents
your network card and select

Properties.
21
Connect using:
I D-Link DFE-530T PCI Fast Ethernet Adapter
LConfig:

Componerts checked are used by this connection:
Highlight Internet Protocol (TCP/ ;";;gf'kﬁjg:;jgfg bzt 2]
IP) and click Properties. TR -

Install Urinstall | Froperies |

- Description

n Control PratacalAlntemet Pratacol. The default
etiwork protacal that provides sommurication
terconnected networkes.

¥ Showican in taskbar when connected

oK Cancel
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Frequently Asked Questions (continued)

Why can’t | access the web based configuration? (continued)

How can | assign a Static IP Address in Windows 20007?

(continued)

Click Use the following IP Address and g rErETrE— 2%
enter an IP Address that is on the same General
subnet as the LAN IP Address on your e e e e e
router. Example: If the router’s LAN IP e P
Address is 192.168.0.1, make your IP € Detain an P adefess autamalialy
Address 192.168.0.X where X = 2-99. i
Make sure that the number you choose is e [5% = 2% 0
not in use on the network. Defaul gatoway: [T e 0 1

£ Obtain DNS server address automatically
Set the Default Gateway to be the @ Uttt ew e
same as the LAN IP Address of your itftdg:z W
router (192.168.0.1). —
Set the Primary DNS to be the same as o

the LAN IP address of your router
(192.168.0.1).

The Secondary DNS is not needed or enter a DNS server from your ISP.

Click OK twice. You may be asked if you want to reboot your computer. Click

Yes.
How can | assign a Static IP i
Address in Windows 98/Me? St ]| A o |

The following network components are installed

Client for Microsoft Networks
D Link DFE 5307+ PCI Fast Ethemet Adapter (Fev 4]

Step 1 From the desktop, right-click on the
Network Neigborhood icon (Win ME - My

Network Places) and select Properties.

tdd. | Pemove | Fuoperies |
PFrimary Network Logon;
Highlight TCP/IP and click the Properties [0ttt etk =
button. If you have more than 1 adapter, _ Beenaiishang._|
then there will be a TCP/IP “Binding” for TEPAP1 o prooce o s comact 0 o et

wide-area networks.

each adapter. Highlight TCP/IP > (your

network adapter) and then click
Properties. Caree
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Frequently Asked Questions (continued)

Why can’t | access the web based configuration? (continued)

How can | assign a Static IP Address in Windows

98/Me? (continued)
Step 2 Click Specify an IP Address.

Enter in an IP Address that is on the same
subnet as the LAN IP Address on your router.
Example: If the router’s LAN IP Address is
192.168.0.1, make your IP Address
192.168.0.X where X is between 2-99. Make
sure that the number you choose is not in
use on the network.

Step 3 Click on the Gateway tab.

Enter the LAN IP Address of your router
here (192.168.0.1).

Click Add when finished.

Step 4 Click on the DNS Configuration tab.

Click Enable DNS. Type in a Host (can be
any word). Under DNS server search order,
enter the LAN IP Address of your router
(192.168.0.1). Click Add.

Step 5 Click OK twice.

When prompted to reboot your computer,
click Yes.

After you reboot, the computer will now have
a static, private IP Address.

Step 5 Access the web management. Open your web
browser and enter the IP Address of your D-Link device in
the address bar. This should open the login page for the web

frdegn | Abvwed | Hemos ]
DS Confpuration | Bateway | WIS Conbguaton 1P Addiers
s % ; :

W ins rrbwacet. dems ol smitcenaticly aciagn P mbbmeoms, nsh
h 1paze besows

™ Ditisin an P addess auiomaticaly

o Gipecly an B ks
ot
s

Hew gateway:
o
Instaedd gatemay:.

Ta2 16801 Femevn

[ |

g Advereed | Heltios
D5 Conbuantion | Gammay | WG Configpasion | 17 dukkmss

€ Disable DNS

1= Erable NS

Host | vt WM|

DNS Server

|
|

management. Follow instructions to login and complete the configuration.

~
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Frequently Asked Questions (continued)

How can | setup my router to work with a Cable modem connection?

Dynamic Cable connection
(i.e. AT&T-BI, Cox, Adelphia, Rogers, Roadrunner, Charter, and Comcast)

Note: Please configure the router with the computer that was last connected directly
to the cable modem.

Step 1 Log into the web based configuration by typing in the IP Address of the router
(default:192.168.0.1) in your web browser. The username is admin (all lowercase) and

the password is blank (nothing). 20
'j:§> Flearte type your uzer name and passward.

Step 2 Click the Home tab and click the Y e 15216801

WAN button. Dynamic IP Address is the Reskn  DIE24

default value, however, if Dynamic IP Address UserName  [sdmn

is not selected as the WAN type, select Pasword |

Dynamic IP Address by clicking on the radio ™ Save tis passord n your password e

button. Click Clone Mac Address. Click on Carcel |

Apply and then Continue to save the

changes.

-AirPlus
MorenmE
High-Speed 2.4GHz Wireless Router

DI-624 I

Home Advanced Tools Status Help

Please selecd the appropriata opSon o connect bo your IEP.

Wizard o

& Dynamic (P Adgress Choose this oplion o oblain an IP address aulomaticalby from
your ISP, (Far most Cable modem users)

" Wireless  Stalic IP Address Choose this oplion 1§81 SEatic P infarmaton provided toyou

b your ISP

 PPEOE Chooze this option ifyour |SF uses FPPOE. (For most DEL
wEers)

© Cihers FFTF and BigPond Cable

{far Europe use only)

Ay

© PPTP
Hosl Name |D|-62-1 {oplionaly
MAC Address [0 oo .Jcs -3 [0 .[0D toptionan

Clona MAL Address I
2 90

Apply Cancel Help
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Frequently Asked Questions (continued)

How can | setup my router to work with a Cable modem connection?
(continued)

Step 3 Power cycle the cable modem and router:

Turn the cable modem off (first) . Turn the router off Leave them off for 2 minutes.**
Turn the cable modem on (first). Wait until you get a solid cable light on the cable
modem. Turn the router on. Wait 30 seconds.

** If you have a Motorola (Surf Board) modem, leave off for at least 5 minutes.

Step 4 Follow step 1 again and log back into the web configuration. Click the Status
tab and click the Device Info button. If you do not already have a public IP Address

under the WAN heading, click on the DHCP Renew and Continue buttons.

Static Cable Connection
Step 1 Loginto the web based configuration by
typing in the IP Address of the router
(default:192.168.0.1) in your web browser. The

i S|

{j.) Please lype your user name and pazsword.
S

ite: 19216801
username is admin (all lowercase) and the password R Ol
. . jsecName [odn
is blank (nothing). —
. [ Save this password in your password kit
Step 2 Click the Home tab and click the WAN ol
button. Select Static IP Address and enter your
static settings obtained from
the ISP in the fields provided. x
P D-Link “AirPlus 5
eI Yorevelz

If you do not know your = High-Speed 2.4GHz Wireless Router
settings, you must contact ® | (S S Advanced _Tools __ Status___Help |
your |SP . ;‘In‘usn saloct the appropriste opsion 1o connect 1o your ISP

 Dymarnic I Address haosa this opan 10 oblain an IP address automatically fom

your ISP, (For most Cable modem users)
& Siatic IP Address nc';llva‘:'o“srelslr;s optior 1o 36l stalic P irformation prowded b you
. i PPPOE uC::;je this aptian if your ISP uses PPPOE. (Far mostDSL
Step 3 Click op Apply and  others PPTR and BigPan Cable
then click Continue to save - oo torEuiope use or
the changes. p—
s P Address 6852120 {assigned by your ISF)

Step 4 Click the Status tab e L —
and click the Device Info pimanONSAdvess 0000
button. Your IP Address SecondanONBAress 0000 —
information will be displayed 2 OO
under the WAN heading. Aoy Cancel Helo
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Frequently Asked Questions (continued)

How can | setup my router to work with Earthlink DSL or any PPPoE
connection?

Make sure you disable or uninstall any PPPoE software such as WinPoet or Enternet
300 from your computer or you will not be able to connect to the Internet.

Step 1 Upgrade Firmware if needed.

(Please visit the D-Link tech support website at: http://support.dlink.com for the latest
firmware upgrade information.)

Step 2 Take a paperclip and perform a hard reset. With the unit on, use a paperclip
and hold down the reset button on the back of the unit for 10 seconds. Release it and
the router will recycle, the lights will blink, and then stabilize.

Step 3 After the router stabilizes, open your browser and enter 192.168.0.1 into the
address window and hit the Enter key. When the password dialog box appears, enter
the username admin and leave the password blank. Click OK.

If the password dialog box does not come up repeat Step 2.
Note: Do not run Wizard.
Step 4 Click on the WAN tab on left-hand side of the screen. Select PPPoE.

Step 5 Select Dynamic PPPoE (unless your ISP supplied you with a static IP
Address).

Step 6 In the username field enter ELN/username@earthlink.net and your
password, where username is your own username.

For SBC Global users, enter username@sbcglobal.net.
For Ameritech users, enter username@ameritech.net.
For BellSouth users, enter username@bellsouth.net.

For Mindspring users, enter username@mindspring.com.
For most other ISPs, enter username.

Step 7 Maximum Idle Time should be set to zero. Set MTU to 1492, unless
specified by your ISP, and set Autoreconnect to Enabled.

Note: If you experience problems accessing certain websites and/or email issues,

please set the MTU to a lower number such as 1472, 1452, etc. Contact your ISP for
more information and the proper MTU setting for your connection.
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Frequently Asked Questions (continued)

How can | setup my router to work with Earthlink DSL or any PPPoE
connection? (continued)

Step 8 Click Apply. When prompted, click Continue. Once the screen refreshes,
unplug the power to the D-Link router.

Step 9 Turn off your DSL modem for 2-3 minutes. Turn back on. Once the modem
has established a link to your ISP, plug the power back into the D-Link router. Wait
about 30 seconds and log back into the router.

Step 10 Click on the Status tab in the web configuration where you can view the
device info. Under WAN, click Connect. Click Continue when prompted. You should
now see that the device info will show an IP Address, verifying that the device has
connected to a server and has been assigned an IP Address.

Can | use my D-Link Broadband Router to share my Internet
connection provided by AOL DSL Plus?

In most cases yes. AOL DSL+ may use PPPoE for authentication bypassing the
client software. If this is the case, then our routers will work with this service. Please
contact AOL if you are not sure.

To set up your router:

Step 1 Loginto the web-based configuration (192.168.0.1) and configure the WAN
side to use PPPoE.

Step 2 Enter your screen name followed by @aol.com for the user name. Enter your
AOL password in the password box.

Step 3 You will have to set the MTU to 1400. AOL DSL does not allow for anything
higher than 1400.

Step 4 Apply settings.

Step 5 Recycle the power to the modem for 1 minute and then recycle power to the
router. Allow 1 to 2 minutes to connect.

If you connect to the Internet with a different internet service provider and want to use
the AOL software, you can do that without configuring the router’s firewall settings.
You need to configure the AOL software to connect using TCP/IP.

Go to http://www.aol.com for more specific configuration information of their software.
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Frequently Asked Questions (continued)

How do | open ports on my router?

To allow traffic from the internet to enter your local network, you will need to open up
ports or the router will block the request.

Step 1 Open your web browser

and enter the |P AddreSS Of Wirtual Server is used to allow Internet users access to LAN services.
your D-Link router & Enabled © Disabled
(192.168.0.1). Enter username Name [pcanywharal Clear |
(admin) and your password Private P [1321680100
(blank by default). Protocal Type  [UDP =]

Private Port |22—
Step 2 Click on the Advanced Public Port [2

on top and then click Virtual Schecle  © Abays

Server on the left side. € From time [00 =] - [00 =] [0 =] 10 [00 =] - [on =] [ama =]

Step 3 Check Enabled to soyfSin Zrofsin 2
activate entry.

Step 4 Enter a name for your virtual server entry.

Step 5 Next to Private IP, enter the IP Address of the computer on your local
network that you want to allow the incoming service to.

Step 6 Choose Protocol Type - either TCP, UDP, or both. If you are not sure, select
both.

Step 7 Enter the port information next to Private Port and Public Port. The private
and public ports are usually the same. The public port is the port seen from the WAN
side, and the private port is the port being used by the application on the computer
within your local network.

Step 8 Enter the Schedule information.
Step 9 Click Apply and then click Continue.

Note: Make sure DMZ host is disabled. If DMZ is enabled, it will disable all Virtual
Server entries.

Because our routers use NAT (Network Address Translation), you can only open a
specific port to one computer at a time. For example: If you have 2 web servers on
your network, you cannot open port 80 to both computers. You will need to configure
1 of the web servers to use port 81. Now you can open port 80 to the first computer
and then open port 81 to the other computer.
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Frequently Asked Questions (continued)

What is DMZ?

Demilitarized Zone:

In computer networks, a DMZ (demilitarized zone) is a computer host or small
network inserted as a neutral zone between a company’s private network and the
outside public network. It prevents outside users from getting direct access to a
server that has company data. (The term comes from the geographic buffer zone that
was set up between North Korea and South Korea following the UN police action in
the early 1950s.) ADMZ is an optional and more secure approach to a firewall and
effectively acts as a proxy server as well.

In a typical DMZ configuration for a small company, a separate computer (or host in
network terms) receives requests from users within the private network for access to
Web sites or other companies accessible on the public network. The DMZ host then
initiates sessions for these requests on the public network. However, the DMZ host is
not able to initiate a session back into the private network. It can only forward packets
that have already been requested.

Users of the public network outside the company can access only the DMZ host. The
DMZ may typically also have the company’s Web pages so these could be served to
the outside world. However, the DMZ provides access to no other company data. In
the event that an outside user penetrated the DMZ hosts security, the Web pages
might be corrupted but no other company information would be exposed. D-Link, a
leading maker of routers, is one company that sells products designed for setting up

aDMZ.

How do | configure the DMZ Host?

The DMZ feature allows you to forward all incoming ports to one computer on the local
network. The DMZ, or Demilitarized Zone, will allow the specified computer to be
exposed to the Internet. DMZ is useful when a certain application or game does not
work through the firewall. The computer that is configured for DMZ will be completely
vulnerable on the Internet, so it is suggested that you try opening ports from the
Virtual Server or Firewall settings before using DMZ.

Step 1 Find the IP address of the computer you want to use as the DMZ host.
To find out how to locate the IP Address of the computer in Windows XP/2000/ME/9x

or Macintosh operating systems please refer to Step 4 of the first question in this
section (Frequently Asked Questions).
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Frequently Asked Questions (continued)

How do | configure the DMZ Host? (continued)

Step 2 Log into the web based configuration
of the router by typing in the IP Address of the
router (default:192.168.0.1) in your web
browser. The username is admin (all
lowercase) and the password is blank

(nOthing) Access Paint
User narme: g admin -

()

Password:

[CIremember my password

[ OK H Cancel ‘

Step 3 Click the Advanced tab and then click on the DMZ button. Select Enable
and type in the IP Address you found in step 1.

D-Link “AirPlus

Building Netwarks for People x7ﬂEMEGm
High-Speed 2.4GHz Wireless Router
; DI-624
Step 4 Click Apply l ™ Home IRTTTCIR Tools  StatusHelp

and then Continue to
save the changes.

DMZ (Demilitarized Zone) is used to allow a single computer on the LAN to be exposed to

SR the Internet

Virtuel Server
© Enabled @ Disabled

Note: When DMZ is P Addess 192 188,00
enabled, Virtual Server
settings will still be — P
effective. Remember, — 2 90
you cannot forward the e
same port to multiple

IP Addresses, so the
Virtual Server settings

will take priority over Performance
DMZ settings.

* Applications

Apply Cancel Help

[l [0
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Frequently Asked Questions (continued)

How do | open a range of ports on my DI-624 using Firewall rules?

Step 1 Access the router’s web configuration by entering the router’s IP Address in
your web browser. The default IP Address is 192.168.0.1. Login using your password.
The default username is “admin” and the password is blank.

If you are having difficulty accessing web management, please see the first question
in this section.

Step 2 From the web management Home page, click the Advanced tab then click
the Firewall button.

Step 3 Clickon D-Link “AirPlus =

Enabled and type in Xrremels

aname for the new High-Speed 2.4GHz Wireless Router
DI-624 .

rule. || SN advanced TSTERCTIRMNTY

Step 4 Choose WAN Flrént;a\\ R;.;I.es can be used to allow or deny traffic from passing through the DI-624

as the Source and g € Enatiad C Dissbied

Mame Clear
Applications Action @ Allow © Deny
Interface IP Range Stat IP Range End Protocal Port Range

enter arange of IP
Addresses out on the

i E

internet that you — soce [ |
would like this rule R L ml” | e @l -
. chedule ways

applied to. If you Firewall ¢ o e [003] - [o0S] [377] o [505] [0 31 Ao ]

would like this rule to day [5um 7] to [0 ]

allow all internet oMz ® 90

users to be able to = - mebaCance! Hely

] ction  Mame Source  Destination Protocal

access these ports, Performance 7 Allow  Allowto Ping WAN port WANS LAN1S2168010  lomPg  [4
- @ Deny Default Fi LAN * IP )"

then put an Asterisk B Alow Defust L e PO

in the first box and
leave the second box

empty.

Step 5 Select LAN as the Destination and enter the IP Address of the computer on
your local network that you want to allow the incoming service to. This will not work

with a range of IP Addresses.

Step 6 Enter the port or range of ports that are required to be open for the incoming
service.

Step 7 Click Apply and then click Continue.

Note: Make sure DMZ host is disabled.

Because our routers use NAT (Network Address Translation), you can only open a
specific port to one computer at a time. For example: If you have 2 web servers on
your network, you cannot open port 80 to both computers. You will need to configure
1 of the web servers to use port 81. Now you can open port 80 to the first computer

and then open port 81 to the other computer. 80




Frequently Asked Questions (continued)

What are virtual servers?

A Virtual Server is defined as a service port, and all requests to this port will be
redirected to the computer specified by the server IP. For example, if you have an FTP
Server (port 21) at 192.168.0.5, a Web server (port 80) at 192.168.0.6, and a VPN
server at 192.168.0.7, then you need to specify the following virtual server mapping

table:
serverport | serverip [ Enable

21 192.168.0.5 X
80 192.168.0.6 X
1723 192.168.0.7 X

How do | use PC Anywhere with my DI-624 router?

You will need to open 3 ports in the Virtual Server section of your D-Link router.
Step 1 Open your web browser and enter the IP Address of the router (192.168.0.1).

Step 2 Click on Advanced at the top and then click Virtual Server on the left side.

Step 3 Enter the
information as seen
below. The Private IP

is the IP Address of the
computer on your local
network that you want to
connect to.

Step 4 The first entry
will read as shown here:

Step 5 Click Apply

and then click Continue.

Virtual Server
Yirtual Server is used to allow Internet users access to LAN services.

& Enabled € Disabled

Mame [pcanywhere M
Private IP IW
Protocol Type ITP;,
Private Part |22—
Public Port 22
Schedule & Always
€ From time [00 x| - [00 7| [AM > o [00 =] - [00 7| [AM =]
day [Sun =] to[Sun =]
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Frequently Asked Questions (continued)

How do | use PC Anywhere with my DI-624 router? (continued)

Step 6 Create
a second entry Wittual Server is used to allow Intermet users access to LAN semvices.

as shown here: & Enabled © Disabled

Marne Ipu:anywherez Clear |
Private IP I192.'|EB.D.'I 0o

Pratocal Type ITCP vl
Private Port |5531

. Public P [5631
Step 7 Click ublie For
Apply and then Schedule = Always
click Continue. C From time |00 x| - [00 =] [AM =] ta [00 =] - 00 =] [AM ¥
dayISun 'lmlSun vl

Step 8 Create _ i _
a third and final irtual Server is used to allow Internet users access to LAN services.

entry as shown

; & Enabled O Disabled
here:

Marng |pcanywher93 Clear |
Private IP I192.1EB.D.1 a0

Pratacal Type Im
Private Port W
Public Port  [BR3z
Schedule & Always
 From timeluuj : IUUj IAMj TDIDDj ;|Dﬂj I’Wj
day m to m

Step 9 Click Apply and then click Continue.

Step 10 Run PCAnywhere from the remote site and use the WAN IP Address of the
router, not your computer’s IP Address. 82



Frequently Asked Questions (continued)

How can | use eDonkey behind my D-Link Router?

You must open ports on your router to allow incoming traffic while using eDonkey.

eDonkey uses three ports (4 if using CLI):

4661 (TCP) To connect with a server

4662 (TCP) To connect with other clients

4665 (UDP) To communicate with servers other than the one you are connected to.
4663 (TCP) *Used with the command line (CLI) client when it is configured to allow
remote connections. This is the case when using a Graphical Interface (such as the

Java Interface) with the client.

Step 1 Open your web browser and enter the IP Address of your router
(192.168.0.1). Enter username (admin) and your password (leave blank).

Step 2 Click on Advanced and then click Firewall.

Step 3 Create a
new firewall rule:
Click Enabled.
Enter a name

AirPlus z
Moremels
High-Speed 2.4GHz Wireless Router

(edonkey). DI-624
Click Allow. | [ Home T USCIM Tools  Status  Help |
Next to Source,

Firgwall Rulos can be usad 10 alkew or dony frafic from passing through 1he DEE24

select WAN ST
under interface. In

the first box,
enter an * Leave Interface IF Range Start P Range Erd  Protocol Pod Range
) Sowca |NA.N;I|‘

[
P—
the second box L Destination [LAM =] [192.166.0.100 = =[qeen . [a6ss

& Enabled T Disabled

Mame ok Clear

Action & Allrw © Deny

empty. Schedule  © Always
Next to € From time [00 =] . [00 =] [ =] 1o [00 =] - o0 =] [aa =
Destination, day [Sun 2] 1o [Bum =]

2 90
Apply Cancel Help

Action Name Sgurce Destination Pratocol

select LAN under
interface. Enter

HEEna-

the IP Address of Performancs F Allgw  llow o Fing WAN pad WAN® LAM19216801  ICMPE |4
F Dory  Defaull LAN" 1P,

the CompUter you F allow  Defaull Lam®s  *F 1P .°

are running

eDonkey from.

Leave the second

box empty. Under Protocol, select *. In the port range boxes, enter 4661 in the first
box and then 4665 in the second box. Click Always or set a schedule.

Step 4 Click Apply and then Continue.
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Frequently Asked Questions (continued)

How do | set up my router for SOCOM on my Playstation 2?7

To allow you to play SOCOM and hear audio, you must download the latest firmware

for the router (if needed), enable Game Mode, and open port 6869 to the IP Address of
your Playstation.

Step 1 Upgrade firmware (follow link above).

Step 2 Open your web browser and enter the IP Address of the router (192.168.0.1).
Enter username (admin) and your password (blank by default).

Step 3 Click on the Advanced tab and then click on Virtual Server on the left side.

Step 4 You will now create a new Virtual Server entry. Click Enabled and enter a
name (socom). Enter the IP Address of your Playstation for Private IP.

Step 5 For Protocol Type select Both. Enter 6869 for both the Private Port and
Public Port. Click Always. Click Apply to save changes and then Continue.

D-Link A
Building mo}slf}nm A”'xp7'lﬂt...5§45 G"’

High-Speed 2.4GHz Wireless Router

DI-624 : >
l [ Home WYL IR Tools Status Help

&

Virtual Server

Yittual Server is used to allow Internet users access to LAN semvices.

@® Enabled © Disabled

Narne ['socom Clar |
Applications Private |P 192.168.0.100
Protocal Type  |Both =

-
Filters Private Port 6869
Public Port 6869
Firewall Schedule ® Always
© From time |00 x| : {00 =] [AM =] to {00 =] . [00 =] |Am =
1 DMZ day |Bun ¥ to|Sun
’
[ @ 90
Performance ) <
tual Servers List Apply Cancel Help
Marme Private [P Protocal Schedule
7 Vittual Server FTP 0.000 TCP 21421 ahways ]
I Virtual Serer HTTP 0.000 TCP 80/0 ahways 2]
7 Vitual Server HTTPS 0.00.0 TCP 4437443 atways Eii|
[T Virtual Server DNS 0.00.0 UDP 53/53 ahways B

Step 6 Click on the Tools tab and then Misc on the left side.

Step 7 Make sure Gaming Mode is Enabled. If not, click Enabled. Click Apply
and then Continue. 84



Frequently Asked Questions (continued)

How can | use Gamespy behind my D-Link router?

Step 1 Open your web browser and enter the IP Address of the router (192.168.0.1).
Enter admin for the username and your password (blank by default).

Step 2 Click on the Advanced tab and then click Virtual Server on the left side.
Step 3 You will create 2 entries.

Step 4 Click Enabled and enter
Settings:

NAME - Gamespy1

W —AirPlus — .
Xoren=
High-Speed 2.4GHz Wireless Router

'": l T Advanced
PRIVATE IP - The |P \c"ﬂw“Sc‘nar I8 whed 16 allow Inlemat usars access 16 LAN sonices
Address of your computer DEGOB

that you are running
Gamespy from.

PROTOCOL TYPE - Both
PRIVATE PORT - 3783

Appiicatian:

Fittors.

iy

192.168.0.100

[3783

[78s

LT

£ From tene [005] - [00°2] [A4 5] 10 [00 5] - [0 =] A =]
tay [Sun =] 1o [Sen =]

2 0O

PUBLIC PORT - 3783 i Aoply Cancet Holp
Name Private 1P Protocol Schadule

I irual Serves FTR ooong TCP 2121 atways Lad5g

SCHEDULE - A|Ways_ B . 0000 TGP EIRD swaye [

T Viusl Serves HTTPS 0000 TCP 443443 ahuys 49

7 Vilusl Sereis DNS 0800 UDPS53S3 sheays 4

Click Apply and then continue.

Step 5 Enter 2nd entry:
Click Enabled orezs |

ST Advanced [T Status Help

it stians

NAM E - Ga m espy2 ‘ - \M‘ul .Sc.nar 5 weed 19 allow Intemat usars access 12 LAN sonices
P R IVATE I P Th I P ‘E ® Engbled © Dreabled 4
- e MHame gamespy2 Cliae

Address of your computer

192.168.0.100

Pratecol Type  [Both =

that youare running e
Gamespy from. e S
PROTOCOL TYPE - Both v P o W

PRIVATE PORT - 6500 a2
PUBLIC PORT - 6500 o wan B
: 0oog TCP 443043 whways 49
I Virnusl Seres DNS oaoon UDP 5353 ahways Pt i

SCHEDULE - Always.
Click Apply and then continue.



Frequently Asked Questions (continued)

How do | configure my router for KaZaA and Grokster?

The following is for KaZaA, Grokster, and others using the FastTrack P2P file sharing
system.

In most cases, you do not have to configure anything on the router or on the KazaA
software. If you are having problems, please follow steps below:

Step 1 Enter the IP Address of your router in a web browser (192.168.0.1).
Step 2 Enter your username (admin) and your password (blank by default).
Step 3 Click on Advanced and then click Virtual Server.

Step 4 Click Enabled and then enter a Name (KaZaA for example).

Step 5 Enter the IP Address of the computer you are running KaZaA from in the
Private IP box. Select TCP for the Protocol Type.

Step 6 Enter 1214 in the Private and Public Port boxes. Click Always under
schedule or set a time range. Click Apply.

“home BTV Tools  Status  Helo

Winual Server is used to allow Interned users access to LAN seraces

= Enabled T Digabled
Nama |kuzua Clear

Private IP 192 168.0.100
Protocol Type |TCF TI
Preate Por 1214

Fublic Part IW
Schedule F Always
& From time [00.2] - [002] [AM =] 1o [002] - [00 2] [ =]
say 5 = oS ]

Make sure that you did not enable proxy/firewall in the KaZaA software.
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Frequently Asked Questions (continued)

How do | configure my router to play Warcraft 3?

You must open ports on your router to allow incoming traffic while hosting a game in
Warcraft 3. To play a game, you do not have to configure your router.

Warcraft 3 (Battlenet) uses port 6112.

For the DI-604, DI-614+. DI-624,
DI-754, DI-764, or DI-774:

AirrPlus =
NE

Step 1 Open your web browser High-Speed 2.4GH=Wiraless Routar
and enter the IP Address of your MIN  Advanced

DI-624 |
‘ Vit Sorver is weed 10 allow Intemat users access 10 LAN somvice
router (192.168.0.1). Enter [_'mw| . ‘ ’
=y
—

. ® Ensbled T Disabled
username (admin) and your T a—rT
password (leave blank). R
P G
i

® Aways

© From time [00 2] . [00 2] [AM =] 10 00 =] - [0 =] [Av =]

Step 2 Click on Advanced and
then click Virtual Server.

. 2 9O
Step 3 Create a new entry: Click . i denly Cone ey
Enabled. Enter a name i eee LY e
(warcraft3). Private IP - Enter the todn, Wit e BN

IP Address of the computer you

want to host the game. Select

Both for Protocol Type Enter 6112 for both Private Port and Public Port Click Always
or set a schedule.

Step 4 Click Apply and then Continue.

Note: If you want multiple computers from you LAN to play in the same game that
you are hosting, then repeat the steps above and enter the IP Addresses of the other
computers. You will need to change ports. Computer #2 can use port 6113, computer
#3 can use 6114, and so on.

You will need to change the port information within the Warcraft 3 software for
computers #2 and up.

Configure the Game Port information on each computer:
Start Warcraft 3 on each computer, click Options > Gameplay. Scroll down and you

should see Game Port. Enter the port number as you entered in the above steps.
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Frequently Asked Questions (continued)

How do | use NetMeeting with my D-Link Router?

Unlike most TCP/IP applications, NetMeeting uses DYNAMIC PORTS instead of
STATIC PORTS. That means that each NetMeeting connection is somewhat different
than the last. For instance, the HTTP web site application uses port 80. NetMeeting
can use any of over 60,000 different ports.

All broadband routers using (only) standard NAT and all internet sharing programs like
Microsoft ICS that use (only) standard NAT will NOT work with NetMeeting or other
H.323 software packages.

The solution is to put the router in DMZ.

Note: Afew hardware manufacturers have taken it on themselves to actually provide
H.323 compatibility. This is not an easy task since the router must search each
incoming packet for signs that it might be a netmeeting packet. This is a whole lot
more work than a router normally does and may actually be a weak point in the
firewall. D-Link is not one of the manufacturers.

To read more on this visit http://www.HomenetHelp.com

How do | set up my router to use iChat? -for Macintosh users-

You must open ports on your router to allow incoming traffic while using iChat.
iChat uses the following ports: 5060 (UDP) 5190 (TCP) File Sharing 16384-16403
(UDP) To video conference with other clients.

Step 1 Open your web browser and enter the IP Address of your router

(192.168.0.1). Enter username (admin) and your password (leave blank).

Step 2 Click on Advanced and then click Firewall.
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Frequently Asked Questions (continued)

(continued)

How do | set up my router to use iChat? -for Macintosh users-

Step 3 Create a new
firewall rule:

Click Enabled.
Enter a name
(ichat1).

Click Allow.

Next to Source,
select WAN under
interface.

In the first box,
enter an *.

Leave the second
box empty.

Next to
Destination,
select LAN under
interface.

Enter the IP
Address of the

D-Link

Eurlding Petwarks for People

Virtu! Sarver

———
Apelcations.

Fillers

311

DMZ

Performande

[

TAIF} 95 us i

High-Speed 2.4GHz Wireless Router

irewall Rules
Firewall Rudes can be used 1o allow or deny trafic from passing through the DEE24

® Ensbled © Disabled

ame ik Clear
Aetion & Aflgw © Deny

iedsce I Renge Start I Range End  Protocol Poel Range
Source |WN‘-Jj|‘ |

Destination [LaN =] [192. 1680000 [

[uor ke [
Schedide & Abways

© Froen time [00 =] . [08 =] [A0 =] o [00 =] . [00 =] [ =]
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@ 00

witll Rules List Apply Caneed Help

Agtion Mame Source  Destination Protetol
F Allow  Allow to Fing WAN port WANT LANE2.163.01 Icmes 4
F Deny Default - [ 1P "
F Allow  Default [0 1P

computer you are running iChat from.

Leave the second box empty. Under Protocol, select UDP. In the port range boxes,
enter 5060 in the first box and leave the second box empty.
Click Always or set a schedule.

Step 4 Click Apply
and then Continue.

Step 5

Repeat steps 3 and 4
enter ichat2 and
open ports 16384-

16403 (UDP).
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-
-
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Frequently Asked Questions (continued)

How do | set up my router to use iChat? -for Macintosh users-
(continued)

For File Sharing:
Step 1 Click on
Advanced and then
Virtual Server.

~AirPlus =,
Xorrenmels

High-Speed 2.4GHz Wireless Router

Step 2 Check Enabled [ tome VOO Tools  Stotus oo |

to activate entry.
“irtual Server is used 1o allow internot usess access to LAN services.

Step 3 Enter a name for

& Enabled © Disablod

DI-624 l
; Hame o —
yoEr ;/értual server entry - e
(ichat3). Protocei Type [TOF 3]
Private Paort 21490
Step 4 Next to Private Y R T
IP, enter the IP Address - Schedile & Avays I — —
€ From time |00 =] - (00 = AM-IW oo = - (00 = AM-I
of the computer on your — =
local network that you
W L
want to allow the 9 O
incoming service to. Apply Concel Help
Mamse Prvate IP - Protoced Schedule
7 Virlusl Seever FTP o000 TER 2121 always IE) |
Step 5 Select TCP for T Vietusl Sesver HTTP 0000 TCP 8080 abways IE) |

Protocol Type.
Step 6 Enter 5190 next to Private Port and Public Port.
Stsp 7 Click Always or configure a schedule.

Step 8 Click Apply and then Continue.

If using Mac OS X Firewall, you may need to temporarily turn off the firewall in
the Sharing preference pane on both computers.

To use the Mac OS X Firewall, you must open the same ports as in the router:

Step 1 Choose Apple menu > System Preferences.

Step 2 Choose View > Sharing.

Step 3 Click the Firewall tab.

Step 4 Click New.

Step 5 Choose Other from the Port Name pop-up menu.

Step 6 In the Port Number, Range or Series field, type in: 5060, 16384-16403.
Step 7 In the Description field type in: iChat AV.

Step 8 Click OK.
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Frequently Asked Questions (continued)

How do | send or receive a file via iChat when the Mac OSX firewall
is active? -for Macintosh users- Mac OS X 10.2 and later

The following information is from the online Macintosh AppleCare knowledge base:

“iChat cannot send or receive a file when the Mac OS X firewall is active in its default
state. If you have opened the AIM port, you may be able to receive a file but not send
them.

In its default state, the Mac OS X firewall blocks file transfers using iChat or America
Online AIM software. If either the sender or receiver has turned on the Mac OS X firewall,
the transfer may be blocked.

The simplest workaround is to temporarily turn off the firewall in the Sharing preference
pane on both computers. This is required for the sender. However, the receiver may keep
the firewall on if the AIM port is open. To open the AIM port:

Step 1 Choose Apple menu > System Preferences.

Step 2 Choose View > Sharing.
Step 3 Click the Firewall tab.
Step 4 Click New.

Step 5 Choose AOL IM from the Port Name pop-up menu. The number 5190
should already be filled in for you.

Step 6 Click OK.

If you do not want to turn off the firewall at the sending computer, a different file sharing
service may be used instead of iChat. The types of file sharing available in Mac OS X are
outlined in technical document 106461, "Mac OS X: File Sharing" in the AppleCare Knowl-
edge base online.

Note: If you use a file sharing service when the firewall is turned on, be sure to click the

Firewall tab and select the service you have chosen in the "Allow" list. If you do not do
this, the firewall will also block the file sharing service. *
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Frequently Asked Questions (continued)

What is NAT?

NAT stands for Network Address Translator. It is proposed and described in RFC-
1631 and is used for solving the IP Address depletion problem. Basically, each NAT
box has a table consisting of pairs of local IP Addresses and globally unique
addresses, by which the box can “translate” the local IP Addresses to global address
and vice versa. Simply put, it is a method of connecting multiple computers to the
Internet (or any other IP network) using one IP Address.

D-Link’s broadband routers (ie: DI-604) support NAT. With proper configuration,
multiple users can access the Internet using a single account via the NAT device.

For more information on RFC-1631: The IP Network Address Translator (NAT), visit
http://www.fags.org/rfcs/rfc1631.html
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Technical Support

You can find software updates and user documentation on the D-Link website.

D-Link provides free technical support for customers within the United States and
within Canada for the duration of the warranty period on this product.

U.S. and Canadian customers can contact D-Link technical support through our web
site, or by phone.

Tech Support for customers within the United States:

D-Link Technical Support over the Telephone:
(877)453-5465
24 hours a day, seven days a week.

D-Link Technical Support over the Internet:
http://support.dlink.com
email:support@dlink.com

Tech Support for customers within Canada:

D-Link Technical Support over the Telephone:
(800) 361-5265
Monday to Friday 7:30am to 12:00am EST

D-Link Technical Support over the Internet:
http://support.dlink.ca
email:support@dlink.ca

When contacting technical support, please provide the following information:
* Serial number of the unit
» Model number or product name

» Software type and version number
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Warranty
(USA only)

Subject to the terms and conditions set forth herein, D-Link Systems, Inc. (“D-Link”) provides this Limited
warranty for its product only to the person or entity that originally purchased the product from:

. D-Link or its authorized reseller or distributor and

. Products purchased and delivered within the fifty states of the United States, the District of
Columbia, U.S. Possessions or Protectorates, U.S. Military Installations, addresses with an
APO or FPO.

Limited Warranty: D-Link warrants that the hardware portion of the D-Link products described
below will be free from material defects in workmanship and materials from the date of original retail
purchase of the product, for the period set forth below applicable to the product type (“Warranty
Period”), except as otherwise stated herein.

1-Year Limited Warranty for the Product(s) is defined as follows:

. Hardware (excluding power supplies and fans) One (1) Year
. Power Supplies and Fans One (1) Year
. Spare parts and spare kits Ninety (90) days

D-Link’s sole obligation shall be to repair or replace the defective Hardware during the Warranty Period
at no charge to the original owner or to refund at D-Link’s sole discretion. Such repair or replacement will
be rendered by D-Link at an Authorized D-Link Service Office. The replacement Hardware need not be
new or have an identical make, model or part. D-Link may in its sole discretion replace the defective
Hardware (or any part thereof) with any reconditioned product that D-Link reasonably determines is
substantially equivalent (or superior) in all material respects to the defective Hardware. Repaired or
replacement Hardware will be warranted for the remainder of the original Warranty Period from the date
of original retail purchase. If a material defect is incapable of correction, or if D-Link determines in its sole
discretion that it is not practical to repair or replace the defective Hardware, the price paid by the original
purchaser for the defective Hardware will be refunded by D-Link upon return to D-Link of the defective
Hardware. All Hardware (or part thereof) that is replaced by D-Link, or for which the purchase price is
refunded, shall become the property of D-Link upon replacement or refund.

Limited Software Warranty: D-Link warrants that the software portion of the product (“Software”)
will substantially conform to D-Link’s then current functional specifications for the Software, as set forth
in the applicable documentation, from the date of original retail purchase of the Software for a period of
ninety (90) days (“Warranty Period”), provided that the Software is properly installed on approved
hardware and operated as contemplated in its documentation. D-Link further warrants that, during the
Warranty Period, the magnetic media on which D-Link delivers the Software will be free of physical
defects. D-Link’s sole obligation shall be to replace the non-conforming Software (or defective media)
with software that substantially conforms to D-Link’s functional specifications for the Software or to
refund at D-Link’s sole discretion. Except as otherwise agreed by D-Link in writing, the replacement
Software is provided only to the original licensee, and is subject to the terms and conditions of the
license granted by D-Link for the Software. Software will be warranted for the remainder of the original
Warranty Period from the date or original retail purchase. If a material non-conformance is incapable of
correction, or if D-Link determines in its sole discretion that it is not practical to replace the non-
conforming Software, the price paid by the original licensee for the non-conforming Software will be
refunded by D-Link; provided that the non-conforming Software (and all copies thereof) is first returned
to D-Link. The license granted respecting any Software for which a refund is given automatically
terminates.

Non-Applicability of Warranty: The Limited Warranty provided hereunder for hardware and software
of D-Link’s products will not be applied to and does not cover any refurbished product and any product
purchased through the inventory clearance or liquidation sale or other sales in which D-Link, the sellers,
or the liquidators expressly disclaim their warranty obligation pertaining to the product and in that case,
the product is being sold “As-Is” without any warranty whatsoever including, without limitation, the
Limited Warranty as described herein, notwithstanding anything stated herein to the contrary.

Submitting A Claim: The customer shall return the product to the original purchase point based on its

return policy. In case the return policy period has expired and the product is within warranty, the
customer shall submit a claim to D-Link as outlined below:
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. The customer must submit with the product as part of the claim a written description of the
Hardware defect or Software nonconformance in sufficient detail to allow D-Link to confirm
the same.

. The original product owner must obtain a Return Material Authorization (“RMA”) number from
the Authorized D-Link Service Office and, if requested, provide written proof of purchase of
the product (such as a copy of the dated purchase invoice for the product) before the
warranty service is provided.

. After an RMA number is issued, the defective product must be packaged securely in the
original or other suitable shipping package to ensure that it will not be damaged in transit, and
the RMA number must be prominently marked on the outside of the package. Do not include any
manuals or accessories in the shipping package. D-Link will only replace the defective portion
of the Product and will not ship back any accessories.

. The customer is responsible for all in-bound shipping charges to D-Link. No Cash on Delivery
(“COD”) is allowed. Products sent COD will either be rejected by D-Link or become the
property of D-Link. Products shall be fully insured by the customer and shipped to D-Link
Systems, Inc., 17595 Mt. Herrmann, Fountain Valley, CA 92708. D-Link will not be held
responsible for any packages that are lost in transit to D-Link. The repaired or replaced
packages will be shipped to the customer via UPS Ground or any common carrier selected by
D-Link, with shipping charges prepaid. Expedited shipping is available if shipping charges are
prepaid by the customer and upon request.

D-Link may reject or return any product that is not packaged and shipped in strict compliance with the
foregoing requirements, or for which an RMA number is not visible from the outside of the package. The
product owner agrees to pay D-Link’s reasonable handling and return shipping charges for any product
that is not packaged and shipped in accordance with the foregoing requirements, or that is determined
by D-Link not to be defective or non-conforming.

What Is Not Covered: This limited warranty provided by D-Link does not cover: Products, if in D-Link’s
judgment, have been subjected to abuse, accident, alteration, modification, tampering, negligence, misuse,
faulty installation, lack of reasonable care, repair or service in any way that is not contemplated in the
documentation for the product, or if the model or serial number has been altered, tampered with, defaced
or removed; Initial installation, installation and removal of the product for repair, and shipping costs;
Operational adjustments covered in the operating manual for the product, and normal maintenance;
Damage that occurs in shipment, due to act of God, failures due to power surge, and cosmetic damage;
Any hardware, software, firmware or other products or services provided by anyone other than D-
Link; Products that have been purchased from inventory clearance or liquidation sales or other sales in
which D-Link, the sellers, or the liquidators expressly disclaim their warranty obligation pertaining to the
product. Repair by anyone other than D-Link or an Authorized D-Link Service Office will void this
Warranty.

Disclaimer of Other Warranties: EXCEPT FOR THE LIMITED WARRANTY SPECIFIED HEREIN, THE
PRODUCT IS PROVIDED “AS-IS” WITHOUT ANY WARRANTY OF ANY KIND WHATSOEVER INCLUDING,
WITHOUT LIMITATION, ANY WARRANTY OF MERCHANTABILITY, FITNESS FORAPARTICULAR PURPOSE
AND NON-INFRINGEMENT. IF ANY IMPLIED WARRANTY CANNOT BE DISCLAIMED INANY TERRITORY
WHERE APRODUCT IS SOLD, THE DURATION OF SUCH IMPLIED WARRANTY SHALL BE LIMITED TO
NINETY (90) DAYS. EXCEPTAS EXPRESSLY COVERED UNDER THE LIMITED WARRANTY PROVIDED
HEREIN, THE ENTIRE RISKAS TO THE QUALITY, SELECTION AND PERFORMANCE OF THE PRODUCT IS
WITH THE PURCHASER OF THE PRODUCT.

Limitation of Liability: TO THE MAXIMUM EXTENT PERMITTED BY LAW, D-LINK IS NOT LIABLE
UNDERANY CONTRACT, NEGLIGENCE, STRICT LIABILITY OR OTHER LEGAL OR EQUITABLE THEORY
FORANY LOSS OF USE OF THE PRODUCT, INCONVENIENCE OR DAMAGES OF ANY CHARACTER,
WHETHER DIRECT, SPECIAL, INCIDENTAL OR CONSEQUENTIAL (INCLUDING, BUT NOT LIMITED TO,
DAMAGES FOR LOSS OF GOODWILL, LOSS OF REVENUE OR PROFIT, WORK STOPPAGE, COMPUTER
FAILURE OR MALFUNCTION, FAILURE OF OTHER EQUIPMENT OR COMPUTER PROGRAMS TO WHICH D-
LINK’S PRODUCT IS CONNECTED WITH, LOSS OF INFORMATION OR DATACONTAINED IN, STORED ON,
ORINTEGRATED WITHANY PRODUCT RETURNED TO D-LINK FOR WARRANTY SERVICE) RESULTING
FROM THE USE OF THE PRODUCT, RELATING TO WARRANTY SERVICE, ORARISING OUT OF ANY
BREACH OF THIS LIMITED WARRANTY, EVEN IF D-LINK HAS BEENADVISED OF THE POSSIBILITY OF
SUCH DAMAGES. THE SOLE REMEDY FORABREACH OF THE FOREGOING LIMITED WARRANTY IS
REPAIR, REPLACEMENT OR REFUND OF THE DEFECTIVE OR NON-CONFORMING PRODUCT. THE MAXIMUM
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LIABILITY OF D-LINK UNDER THIS WARRANTY IS LIMITED TO THE PURCHASE PRICE OF THE PRODUCT
COVERED BY THE WARRANTY. THE FOREGOING EXPRESS WRITTEN WARRANTIES AND REMEDIES
ARE EXCLUSIVEAND ARE IN LIEU OF ANY OTHER WARRANTIES OR REMEDIES, EXPRESS, IMPLIED OR
STATUTORY

Governing Law: This Limited Warranty shall be governed by the laws of the State of California. Some
states do not allow exclusion or limitation of incidental or consequential damages, or limitations on how
long an implied warranty lasts, so the foregoing limitations and exclusions may not apply. This limited
warranty provides specific legal rights and the product owner may also have other rights which vary
from state to state.

Trademarks: D-Link is a registered trademark of D-Link Systems, Inc. Other trademarks or registered
trademarks are the property of their respective manufacturers or owners.

Copyright Statement: No part of this publication or documentation accompanying this Product may
be reproduced in any form or by any means or used to make any derivative such as translation,
transformation, or adaptation without permission from D-Link Corporation/D-Link Systems, Inc., as
stipulated by the United States Copyright Act of 1976. Contents are subject to change without prior

notice. Copyright® 2002 by D-Link Corporation/D-Link Systems, Inc. All rights reserved.

CE Mark Warning: This is a Class B product. In a domestic environment, this product may cause radio
interference, in which case the user may be required to take adequate measures.

FCC Statement: This equipment has been tested and found to comply with the limits for a Class B

digital device, pursuant to part 15 of the FCC Rules. These limits are designed to provide reasonable

protection against harmful interference in a residential installation. This equipment generates, uses, and

can radiate radio frequency energy and, if not installed and used in accordance with the instructions,

may cause harmful interference to radio communication. However, there is no guarantee that interference

will not occur in a particular installation. If this equipment does cause harmful interference to radio or

television reception, which can be determined by turning the equipment off and on, the user is encouraged

to try to correct the interference by one or more of the following measures:

. Reorient or relocate the receiving antenna.

. Increase the separation between the equipment and receiver.

. Connect the equipment into an outlet on a circuit different from that to which the receiver is
connected.

. Consult the dealer or an experienced radio/TV technician for help.

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions:
(1) This device may not cause harmful interference, and (2) this device must accept any interference
received, including interference that may cause undesired operation.

FCC Caution: Any changes or modifications not expressly approved by the party responsible for com-
pliance could void the user's authority to operate this equipment.

IMPORTANT NOTE: FCC Radiation Exposure Statement:
This equipment complies with FCC radiation exposure limits set forth for an uncontrolled environment.

This equipment should be installed and operated with minimum distance 20cm between the radiator &
your body. To maintain compliance with FCC RF exposure compliance requirements, please avoid direct
contact to the transmitting antenna during transmitting.

This transmitter must not be co-located or operating in conjunction with any other antenna or transmitter.
We declare that the product is limited in CH1~CH11 by specified firmware controlled in the USA.

For detailed warranty outside the United States, please contact corresponding local
D-Link office.
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Registration

[ Register your D-Link product online at http://support.dlink.com/register/ ]

(10/11/04)
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